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Radio as a Medium 
 

 Radio is a medium for hearing. With radio, listeners can only hear and imagine objects, 

actions and ideas.  

 Radio lacks permanence. The audience may not read and re-read messages as in the 

print press. 

 Radio has no visuals. There is no image and no text. The receivers cannot see the 

sender or broadcaster as they do on television or film.  

 Radio stimulates imagination. The listeners supply the visual data for themselves. They 

picture the messages suggested by voices, words and sound effects. 

 Radio is personal and intimate. Warmth, compassion, anger, pain and laughter are 

conveyed more adequately through audio. With accent, inflection, hesitation, pause, 

and a variety of emphasis and speed the voice is able to convey far more than the 

printed speech. 

 Radio listeners do other things. They can be traveling, driving or washing clothes. One 

disadvantage to this is that the audience may be only half listening, and much of the 

message could be missed, ignored or misunderstood.  

Introduction to Community Radio 
 

In an age when the mass media are increasingly losing their influence and the trust of 

citizens worldwide, community radio is starting to play an important role in empowering 

people by giving a voice to those marginalised by society, building and supporting strong 

communities, as well as providing information to citizens that enable them to make 

informed decisions that affect their everyday lives.  

Community radio is about the horizontal exchange of information, where the interaction 

between the community and the station takes place in a participatory way, as opposed to 

the vertical, one-way communication model implemented by the mainstream media. 

Community radio empowers communities not only by improving their media literacy levels, 

but also giving communities and marginalised people agency and strengthening their 

democratic participation and active citizenship. 

 

“Community radio responds to the needs of the community it serves, contributing to its 

development within progressive perspectives in favour of social change. Community radio 

strives to democratize communication through community participation in different forms 

in accordance with each specific social context.”  
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World Association of Community Broadcasters (AMARC), 1998 

 

The scope of the actual and potential impact of community radio is wide-ranging. In so-

called developing countries, mainstream media are concentrated in large urban areas, and 

community radio is considered the most effective tool for getting information to illiterate, 

poor and geographically isolated communities. 

“The focus is on dialogue, on finding solutions, on the future rather than who did what to 

whom…, on bringing all the stakeholders together and through the radio trying to calm 

situations down and move the society toward peace and democracy” 

Carole Frampton, Former Director of Institutional Learning, Search for Common Ground 

What are the distinguishing features of Community Radio? 

 Serves a community or communities distinguished by features such as geographical 

location, community of interest etc. 

 Non-profit that serves the public interest rather than commercial interests 

 It encourages democratic participation 

 Ensures broad participation in radio programming, management and ownership of the 

station by community members, often on a volunteer basis,  

 Uses communication within and across communities to facilitate positive change 

 Has transformative potential in terms of community development and social change 

 Does not have sponsors imposing program policy and content, i.e. it is in the interests 

of the well being of the community 

 Has an open, egalitarian nature that encourages broadcasters to take ownership 

 

Community radio gives its members access to information because it gives them access to 

the means of communication. The most relevant information - educational and 

developmental - is disseminated and exchanged. Important local issues are aired. People 

are given the opportunity to express themselves socially, politically and culturally. 

Why do we need community radio?  

 

      Watch: https://www.youtube.com/watch?v=funocbYwOdM 

Watch: https://www.youtube.com/watch?v=RZGvRuPKwAk 

 

https://www.youtube.com/watch?v=funocbYwOdM
https://www.youtube.com/watch?v=RZGvRuPKwAk
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Community Radio Station Case Studies 

UNESCO Radio ICTs project is empowering local communities in 

Africa 

“The UNESCO-led project “Empowering Local Radios with 

ICTs” aims to improve the quality and variety of radio 

programming in vulnerable communities by increasing 

their capacities in important information and 

communication technology (ICT) skills. 

In this fascinating video, we explore some of the crucial 

ways the project is helping local communities in Southern 

Africa to find their voice and discuss the issues that are important to them. We hear from 

radio producers, presenters and members of the public, who all attest to the strong and 

positive impact of this key UNESCO project in their lives.” 

Watch: https://www.youtube.com/watch?v=EV1srcwMy1E 

 

Roxby Council Community Radio Station 

“Roxby Downs, a very remote but vibrant 

community purpose built in 1988 to service the 

giant Olympic Dam Mine. 

They do it different in Roxby Downs, they even 

support a Community Radio Station - RoxFM. 

Council doesn't run the station, but have helped 

to fund it, accommodate it in their facilities and 

they have staff that have programs that air on the station. The radio station operates 

independently. The Community Radio Station is really important and is located in their 

Community Cultural Centre. Communication through this medium is extremely effective 

within the community. 

The community radio station is run by a Board of volunteers and so are all the radio 

programs. On air music is pumped through to the main street.” 

Watch: https://www.youtube.com/watch?v=Jrk0Gb32v-Y 

 

https://www.youtube.com/watch?v=EV1srcwMy1E
https://www.youtube.com/watch?v=Jrk0Gb32v-Y
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KGNU Youth Radio Workshop 

 

KGNU Community Radio puts on a youth workshop, 

teaching kids how to use equipment and basic 

interviewing skills. 

 

 

Watch: https://www.youtube.com/watch?v=KU4lTLF4Ys4 

 

Collaborative Programming, Self-Management and Operations 
Participation in community radio exists at all levels – from planning to implementation and 

evaluation of the project. The community is involved in the decision-making process, 

including making decisions about the content, duration and program schedule. They also 

have a voice in the management and financing of radio program projects. Once the 

community members gain necessary experience and the required skills, there is no reason 

for preventing them from managing and owning the radio station. 

Program Makers  

A core of selected community members who have the time, ability and enthusiasm are 

chosen to prepare regular programs. They can be from various sectors of the community. 

They are volunteers and they undertake the day-to-day operation of the station. They 

serve as producers, announcers, hosts, scriptwriters, news gatherers, technicians and 

administrative personnel. Under the leadership of the designated senior manager, they 

prepare programs, operate the equipment, and handle the administrative responsibilities 

of the station. 

Funding 

Private individuals are motivated to contribute to the station. Various fund raising schemes 

such as raffle draws and benefit dances etc are held. Institutional advertisements or 

sponsorships or outright donations are accepted. Host institutions such as schools, 

foundations, cooperatives, local government units and religious organisations may also 

provide support. 

https://www.youtube.com/watch?v=KU4lTLF4Ys4
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Programming 

Community radio’s program format is similar to that of a mainstream radio including news, 

drama, talk shows, interviews and magazine. However, in community radio programs, 

there is a heavy emphasis on local content. For example, news content focuses on events 

coming from the municipality, villages and local organizations. Discussions can focus on 

issues of local concern such as campaigns, protests, festivals etc. 

 

Broadcasting Hours 

The broadcasters and the management council determine the broadcast hours for a 

community radio on the basis of the following:  

 

 capability and number of trained personnel;  

 availability of electricity or power;  

 technical feasibility;  

 needs of the community/audience;  

 availability of resources necessary for operation;  

 competition with other radio stations. 

 

With such considerations, community radio normally comes up with shorter broadcasting 

hours than commercial or government or public radio. 

 

How to Broadcast On Air - Things to Remember 
 

The community radio broadcasters are responsible for the image of their individual 

radio program and radio station. How the broadcasters conduct themselves on the 

radio, at the station or elsewhere reflects not only their own personality but also 

the integrity of the radio station.  

 

1. Prepare for The Program  

A radio program must present new ideas, information and points of view. Hence, 

an announcer should always read, research and secure information from reliable 

sources. He/she must organise the program well before going on air.  

 

2. Keep a Good Taste  

The broadcaster should always choose wholesome topics, language, jokes and 

presentation. Obscenity, blasphemy, profanity and vulgarity should be avoided. 
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Listeners, especially children and youth, should always be able to uphold the 

announcer as a model of propriety in action and language.  

 

3. Be Prompt and Punctual 

A broadcaster should come to the studio no less than 10 minutes before broadcast 

time. In the case of a known reason for non-arrival he/she should inform his/her 

station manager at least a day before the broadcast, or earlier. Only in an 

emergency situation may an announcer be absent without advance notice. 

 

Radio Interview Techniques 
 

Interviews add human interest and variety to stations as well as introducing new 

information and experts in contact with the listeners, i.e. other community 

members. 

 During the Interview: 

 Listen closely to your interviewee(s) – maintain eye contact as much as 

possible, stay interested and engaged and respond to what they’re actually 

saying. Avoid looking at the microphone! 

 Take control of the interview – when you hear something that 

interests/motivates/moves you, stay on the topic - steer the conversation if the 

guest is being boring or evasive, making it clear to them if they are avoiding to 

answer your question 

 Take your own notes – Note down key points, quotes, or any questions or 

stories you might want to go back to later in your interview 

 

 Don’t rehearse – To the extent possible avoid rehearsing your questions with a 

guest. Spontaneity is essential for a good interview. Some interviewees 

(especially public officials) may ask for the questions beforehand - you can just 

discuss the general topics with them. 

 Ask questions with proper scope - If you ask too open a question, it will 

eventually turn into a monologue; and too narrow a question makes the 

conversation halting. Therefore, make sure your questions have a focus and a 

proper scope in order to achieve a flowing dialogue.  
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 Don’t hesitate to record again – If you are recording make sure you are happy 

with your material. If your interviewee makes a mistake, ask them to repeat 

themselves 

 

 Avoid: Multi-faceted and long questions – don’t ask several questions at once. 

Your guest is likely to best answer the most familiar part, and may not even 

remember the rest of questions! Long extravagant questions are likely to give 

you a boring answer 

 Instead: Prioritise, keep it simple and be clear about what you want to know 

 

 Avoid: Leading questions – These are formulated in order to lead to a certain 

type of answer. Remember that we are not lawyers! While this is a good tactic 

to use in certain cases, try to do it consciously when necessary. In particular, 

when interviewing representatives of vulnerable groups you want them to 

describe/report the facts as they know them, rather than to lead them into 

hyperbole, overstatements or errors 

 Instead: Go for open-ended questions that allow your guests the flexibility to 

express themselves 

 

 Avoid: Editorialising questions – Stating an opinion and asking for a response. 

The guest will figure out that it’s your opinion, even if you don’t say so and 

won’t be as honest or open with you 

 Instead: Ask your guest to respond to the opinion expressed by someone else, 

if that is the point of the interview 

 

  Avoid: Questions that include assumptions – if your guest doesn’t agree with 

your assumption, they may be confused or offended e.g. public officials are 

likely to use this as an opportunity to move off topic 

 

  Avoid: Trigger words – Certain (loaded) words can set guests off 

unnecessarily, especially if they are sensitive to them 
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 Avoid: Bias – An easy mistake to make; certain phrases or words can lead to 

dishonest answers. So instead of asking “How much are you enjoying this 

training?”, ask “What do you think about this training?” 

 

 Avoid: Either/Or questions – They limit the range of responses you can get. 

Interviewees are likely to pick just one option or the other e.g. public officials 

are likely to use this as an opportunity to move off topic 

 

 Avoid: Leading with verbs – Only to be used for obtaining basic factual 

information. Generally questions that start with a verb are always answerable 

with a yes or no response, and are not suitable for exploring a complicated 

issue 

 

 Avoid: Making noises – Try not to laugh out loud, try to avoid "uh-huh" or 

other vocal affirmations  

 Instead: Try to use head movements e.g. nodding and eye contact 

 

 Avoid: Sounding Ignorant - This does not reflect good on the broadcaster or 

the station. 

 Instead: Do your research and check your facts before you start your 

interview. 
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Introduction to Podcasts  

What is a Podcast? 

 

A podcast is a digital medium consisting of an episodic series of audio files 

subscribed to and downloaded through the web or streamed online to a computer 

or mobile device. The word derives from "broadcast" and "pod" from the success 

of the iPod. As podcasts are often listened to on portable media players, it gives 

listeners control over when, where and how they listen. Once you subscribe to a 

podcast feed, new podcasts are automatically downloaded to your 

computer/mobile device as soon as they are available. They are also easy to 

archive and updating them is quick and easy. 

 

Portable Audio Recording  

 (e.g. mobile phone/tablet etc, including mobile applications) 

 

There are alternative ways to produce audio/podcasts where you don’t need 

expensive, high end equipment or software to do so. 

 

It is a reasonable assumption that these days almost everybody has - or has 

access to - a mobile phone. All telephones require a microphone and speaker, and 

some have connectors for external audio peripherals. These may be accessed by 

other applications for voice recording, audio playback, analysis and measurement, 

synthesis and many more audio applications. Although there are limitations to the 

quality of recording which can be achieved on a phone (at least at the present 

time), its size, portability and familiarity make it useful as a quick and easy audio 

recorder. 

  

Recordings on phones will almost always be monophonic, and reliant on the quality 

of the built-in microphone, but if this is sufficient for your needs then positioning 

your phone to pick up your desired source can allow you to capture a rough 

recording. 

A couple of newer smart phones such as the iPhone have significant internal 

memory, and can record in CD quality, or a compressed equivalent. Additionally, 

some also allow connection of external microphones, which can offer significant 

further improvements to recording quality. Examples of this are the following: 

 

http://en.wikipedia.org/wiki/Digital_media
http://en.wikipedia.org/wiki/Digital_media
http://en.wikipedia.org/wiki/Digital_audio
http://en.wikipedia.org/wiki/Digital_audio
http://en.wikipedia.org/wiki/Download
http://en.wikipedia.org/wiki/Download
http://en.wikipedia.org/wiki/IPod
http://en.wikipedia.org/wiki/IPod
http://en.wikipedia.org/wiki/Portable_media_player
http://en.wikipedia.org/wiki/Portable_media_player
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These are ideal solutions for on-the-go 

recordings and they also come with applications to edit and publish your podcasts 

straight from your phone or tablet device. 

Recording Skype conversations 

If you cannot personally meet with people you want to interview, you can easily 

record a telephone interview via Skype, using this cheap and easy to use phone 

application: 

 

http://ejc.net/resources/article/skyrecorder-record-skype-conversations 

 

 Alternatively, you can use a portable audio recorder, such as the Zoom H4N. This 

is a professional audio recording device which records on .mp3 and .wav formats. 

This device can be connected to a video camera through XLR connections, or used 

as a portable device for producing podcasts or recording any form of audio. The 

attached microphones are highly sensitive condenser microphones, and can pick up 

the slightest of sounds. Therefore, it is important to make sure you are recording 

in a quiet environment if possible. If recording in a crowd or anywhere with 

external, natural sound (e.g. on the street), make sure to keep the microphones 

close to the person’s voice when recording an interview. It is also important to 

wear a good pair of headsets to make sure you 

monitor your recording.  

 

Zoom H4N Portable Audio Recorder 

 

 

 

Tascam iM2 Microphone for iPhone 

http://tascam.com/product/im2x/ 

 

iXY Rode Microphone for iPhone 

http://www.ixymic.com/ 

http://tascam.com/product/im2x/
http://www.ixymic.com/
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This audio recorder uses SD cards for memory storage, so once you have finished 

your recording, you can simply remove the card, place it in a card reader and copy 

your files to your computer. Remember, you can record in either .wav or .mp3 

format - a .wav format is an uncompressed file, therefore your file size will be 

larger. An .mp3 format is a compressed file, so the file size will be much smaller, 

but also much more practical for transferring or sending online. Provided you have 

a clear, crisp recording, an .mp3 file is adequate for a podcast. 

 

 

CLASS EXERCISE: Split into groups or pairs and choose an interviewer and 

interviewee(s). Take some time to pre-chat and prepare for an interview on 

“Challenges surrounding the youth”. Conduct and record an approximately 10-

minute long interview paying attention to the points mentioned above 
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  Audio Editing 

An Introduction to Audacity 

Another way you can record your material is through your computer. This is 

provided you are in a controlled environment and do not need to go to other 

people or record ‘in the field’. There are various softwares available for you to do 

this, but one we will be looking at is Audacity. We selected this one and 

recommend it to you on the strength that it is fairly easy to use and free! 

How to Install Audacity 

Audacity is free software that is available to download from the internet from the 

website: http://audacity.sourceforge.net/ 

 

Follow the links to download a copy of the software (1.3 beta) version 

recommended) - Mac and PC compatible. 

 

When the file is opened it initiates the installation processes for the Audacity 

software. Once the process is complete, the software will be fully installed and an 

icon will appear on your computer to enable you to open it. 

 

 

GETTING STARTED: Here is a link with simple instructions on how to use Audacity: 

http://www.wikihow.com/Record-a-Podcast-with-Audacity 

 

Control Toolbar 

 
  

This toolbar works very much like a video or cassette recorder. 

http://www.wikihow.com/Record-a-Podcast-with-Audacity
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 Record – initiates the recording of an audio file 

 Pause – temporarily stops the recording or playback. This comes in useful if 

you record one part of your podcast and then want to prepare yourself for the 

next section. To restart the recording press the pause button again. 

 Stop – ends the recording or playback. This must be done before any further 

editing is carried out 

 Play – plays back a recording 

 Back Skip - skips to the beginning of the recording 

 Forward Skip – skips to the end or to a position where the cursor is placed 

 The Cursor – this is a very useful tool that can be used to select a certain 

position in a recording or selecting a sample of the recording to be edited. 

 

The only other feature that is important at this stage is the input device. If you 

click the drop down arrow you’ll see a list of four options, we need to select the 

input we’ll be using for vocal recording the Microphone. 

 

Considering Recording Conditions 

When making a recording you need to remember the microphone will pick up most 

of the sound made around it during that time. Here are some tips to consider: 

1. Background noise - the recording will pick up other sounds made in the room 

including other people talking, machine noise and telephone rings. To avoid 

this it is best to record in a quiet room. 

2. Microphone position - the microphone doesn’t have to be close to your 

mouth, as it tends to pick up unwanted noises like inhaling and exhaling, plus 

the recording tends to be loud if the microphone is to close. 

a. However, when making a recording try a keep the microphone at a constant 

distance from your mouth because varying the distance changes the level of 

the recording. This is helped by the use of a headset. 

3. Try to do all the recording on the same computer as different machines have 

different ambient sounds which will vary throughout the recording if not done 

on the same machine. 

 

 

 

 

 

Starting Recording 

Before you start recording, do a few last minute final checks: 
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 Check your microphone is plugged in  

 Check that the input is set to microphone  

 Check that the sample rate is set to 44,100Hz 

  

Press record and start 

speaking. As you talk, you 

will notice a sound wave 

trace of your voice. Also, 

the metre toolbar will 

move according to the 

sound of your voice, and 

the timer positions at the 

bottom of the screen will 

be counting (some of these 

features can be seen in fig 

3.) 

When you press stop an 

audio track summary will appear on the left hand side of the sound wave. 

 

At this stage it’s a good idea to listen to your recording, it may be strange to listen 

to your own voice for the first time, but this is a natural reaction. If you think it is 

too loud, you can adjust the record volume level by moving the tab on the 

microphone section of the Mixer Toolbar (fig 4). It’s a good idea to play with this 

until it’s at a level that is suitable. 

 

                      

What if I make a mistake when recording? 

  

When recording it can be frustrating if you say the wrong thing or make a mistake, 

especially if you are doing a long recording, because you may need to start again.  

 

1. DON’T PANIC! 

2. Before you start your recording again, stay silent for about 3 seconds - this 

produces a flat-line in the sound that can be used to identify the mistake later. 
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3. If you require time to compose yourself press the Pause button to temporarily 

stop the recording. Then press the pause button again to continue the 

recording.  

4. Continue by repeating the section leading up to the mistake and carrying on 

with the correct dialogue. 

 

To remove the mistake, listen to the section in which you made the mistake to 

decide what needs to be removed. This may take a few attempts. 

Once you’ve decided what needs to be removed from the recording, using the 

cursor highlight the section as seen in fig 6. This is done my left clicking the mouse 

at the start of the section, then, whilst holding down the left mouse button move 

the cursor along the require section. 

Then to remove this section of the recording press the Delete key on the keyboard 

and the sound wave will realign itself as shown in fig 7, shortening the length of 

the recording by the amount of time removed. 

 

1.Section with the   

mistake 

2.Silent for 3 

seconds and 

maybe pause 

3.Continue with the 

correct dialogue 
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What if I want to add some more dialogue to my recording? 

 

If you’ve made a recording, but once you’ve listened to it feel you’ve missed 

something out, simply press record again. This will open a second Audio Track, as 

seen in fig 8  

 

To place this audio track into the position required in the recording, use the Time 

Shift tool found in the Control Toolbar. This is done in the following steps:  

1. Position the cursor at the point in the recording where the second recording will fit 

in, shown in Fig 9. 
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2. Then go to the Edit menu on the menu bar and select the Split option. This creates 

a small gap in the recording as shown in Fig 10. 

3. Using the Time Shift tool hold the cursor over the second audio track recording, 

click and hold down the left mouse button and move the recording to a position 

where the start of it is aligned with the split as shown in fig 11. 

4. Finally do the same with the sound wave to the right of the split in the first Audio 

Track. Using the time Shift Tool, positioning it at the end of the recording in the 

second audio track, as shown in fig 12. The recording will now play seamlessly with 

the new dialogue added. 
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Personalising your recording 

Once you’ve completed your recording and happy with how it sound, you can now 

personalise it, this mean giving it a title and putting your name on it. 

  

This is done by going to the Project menu on the Menu bar and selecting Edit ID3 

Tags, which brings up the box.  

 

 This allows you to add a Title to your recording, i.e. main theme of the 

Podcast.  

 The Artist name which is you if you recorded it.  

 An Album name, this could be the name of a series of Podcasts.  

 If your recording is one of a series of Podcasts it’s position in the order can be 

put in the Track Number. The year it was produced can be put in the Year box.  

 For the Genre this can be selected from a large list, as a Podcast tends to be a 

vocal recording this is the genre selected. 

 Finally if you wish you can add further comments.  

 Finish and save the information by pressing OK. 

 

Saving Your Recording 

You can save your product by going to the File Menu and selecting Save Project 

As… This option saves the recording as an ‘Audacity Project’ which is a format 
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called .aup. The format can then be listened to again but only on Audacity 

software. Unfortunately this format can not be played on typical digital audio 

devices. Therefore the file has to be converted into an mp3 format, which is much 

more accessible, which can be done by selecting the Export As mp3 option on the 

File Menu. 

 

Unfortunately Audacity doesn’t have the inbuilt ability to do this, to achieve this 

therefore as add-on called lame_enc.dll has be downloaded from the internet and 

is also free. 

 

The easiest way to find this is to go use any internet search engine, type in the 

name of the file as printed above and more often than not the first item to appear 

on the list is website to download it. 

 

Once you have found a source, download the file much in the same way the 

Audacity program was downloaded. However, this time it doesn’t have an install 

process, the file just needs to be on the computer. 

 

1. Once the file is on your computer your recording can be converted to a .mp3 

format in the following steps: 

2. On the File Menu select Export as mp3. 

3. This leads to a save window, which requires you to name your recording and 

select where you would like to store it on your computer. Select OK. 

 

The first time this process is carried out the message shown in Fig 14 will appear:

 
 

This is asking you to locate the lame_enc.dll file, select yes and then use the 

browser to find the file downloaded. 

 

Thankfully this step of the process only has to be done once, from then on the 

Audacity will convert to .mp3 quite happily and only steps 1 & 2 are needed to 

convert.  
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Considering File Size 

When recording a Podcast considering the file size is very important, because at 

the end of the project the file will be made available on the internet, and when 

getting files from the internet the larger they are the longer they take to download. 

Therefore they want to be made as small as possible. To achieve this with a sound 

file there are three variables that can be altered: 

 

1. The Sample Rate, this is a measure of how many times a second the 

computer makes a recording of your voice. Audacity has default settings 

between 11025Hz and 96000Hz. Hertz (Hz) is a frequency measure of per 

second. Therefore, lower frequency means fewer recordings per second. Of 

course lower frequency also means lower quality. 

2. Sample Format, this is measured in bit. It simple means how bits of computer 

memory space the recording uses for each second of recording. Therefore, 

once again the lower the number, the lower the quality. 

 

Both of these setting can be altered in the Edit Menu in the Preferences section. 

This opens a window called Audacity Preferences, once in this window select the 

Quality Tab as shown in fig 15. 
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The two variables discussed above can be changed in the top two drop down 

boxes. It is recommend the settings show of a Sample Rate of 44100Hz and a 

Format of 16-bit. These are also the settings used by the BBC to produce their 

Podcasts and CDs. 

 

3. The final variable that can be altered is changing the Bit-rate of the .mp3 

created. An .mp3 is a computer sound file and the Bit-rate is how many bits, or 

how much of that file is played back to you in one second. 

 

This to can be altered in the Edit Menu in the Preferences section, this time in the 

File Format tab, shown in Fig 16. 

 

 
  

Audacity has a default setting of 128 and this is quite a typical rate for an .mp3 

file, however this quality is only required for music files. For a voice recording it 
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can be much lower, and if the Bit-rate is much lower it decreases the file size 

dramatically. 

 

 

CLASSWORK EXERCISE: Using the interviews you recorded in the previous 

exercise, create a podcast using voiceovers and music of your choice. 

 

  



 
23 

  

 

 

Using Social Media for Community Radio Outreach 
Social media is key element in the success of community radio. They form an integral part 

of a station or programme’s outreach and networking strategies, enabling contact with 

both a local and an increasingly global audience. Some may reach out to diverse 

audiences, while others will attract people based on common language or shared racial, 

sexual, religious, or ethnic group identities. 

 

Twitter for Community Radio 

The social media platform that is fast-becoming one of the main sources of news around 

the world, Twitter has changed the ways in which we consume and distribute news, and at 

the same time enabling global communication and conversations. The format of Twitter 

allows for quick updates about events as they are taking place, and represents a quick and 

effective of supporting and promoting community radio. In an age of all things digital, 

Twitter is an excellent marketing tool. In 140 characters, you can update your audience on 

what is going on in and around the radio station, inside the studio, and what’s playing on 

air. 

Twitter users ‘follow’ each other with the aim of engaging with specific people and/or 

organisations. A constant stream of tweets keeps users up to date on issues, events and 

conversations. Unlike other social media platforms, on Twitter it is possible to just ‘follow’ 

or be followed. 

Twitter Tips for Broadcasters 

Your Profile: 

 Think carefully about your handle (@) – you don’t want it to be too long because it 

uses up characters 

 Personalise it - Use an image, preferably use a picture of yourself (or the logo of your 

show) 

 Utilise as much of the 140-character limit –include keywords such as handles (@) or 

hashtags (#) - see below - that your followers or potential followers may be looking for 

 Create/add your own background image – avoid monochrome 

Use Hashtags 

 Create a hashtag for your show - For example #Rangarang. And stick to it – this will 

make it easier for people searching for entries on your show 

 Always add hashtags to your tweets – about issues that your show deals with e.g. 

#Poverty #Racism 
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 Hashtags as live feedback – Community radio stations and programmers can use 

hashtags as a method of generating real time discussion and feedback while on air 

Engage your Followers: 

 Retweet other people’s posts that you find interesting and relevant – you should 

definitely retweet and participate in conversations with people who have a lot of 

followers 

There are two ways to retweet: 

 The easy way: Click the ‘retweet’ button 

 The complicated (but most effective) way: Copy the tweet, place it in front of the 

writer’s handle and put ‘RT’ at the beginning of the tweet 

 Always keep some space available in your own tweets in case someone wants to 

retweet your post in the complicated way 

Frequency & Timing: 

 Tweet as often as you can - it is unlikely that anyone will follow you if you have not 

tweeted in months. Try at the very least to tweet a few times a week or daily if you 

can 

 Time your tweets (if you can) - there is no optimal time to tweet, but you are in 

control of creating a pattern to your tweets 

Photographs: 

 Tweet photos – for obvious reasons - people are attracted to visuals! 

Don’t be afraid to tweet: 

 Tweet to Presidents, Prime Ministers, Parliamentarians … you will be pleasantly 

surprised by their response! 

Create (and use) Twitter lists: 

 Twitter lists can help you filter through the people you follow. To create a list, click the 

‘Lists’ link and then ‘Create’ a list. After creating a list visit the person’s profile page 

you wish to add and click the list icon 

Map your Twitter activity: 

 Commun.it - http://commun.it/ - helps you track activity on your account, including 

who followed and unfollowed you, people who you should follow, people you should 

unfollow, what you should have for dinner… 

 

http://commun.it/
http://commun.it/
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Use Twitter on Mobiles: 

 Apple iPhones, Blackberries, Androids, Windows phones, and most of the other smart 

phones have Twitter applications. Use them. It is the easiest to tweet photos. 

Get your guests involved: 

 Check if they have a Twitter account - follow them, tag them in a tweet about the 

show, and encourage them to retweet 

What makes a great tweet: 

 “Tune into #TamilOlie (show) on @MYCYradio (radio) from 4pm (time) – talking to 

@CCMCCyprus (who) about #socialmedia (subject) in #Cyprus (where)” 

 And a not so good tweet: 

Today at 4 we are talking to @CCMCCyprus about social media on mycyradio 

Facebook Tips for Broadcasters 

Since its launch as only a small social networking website available for Ivy League 

universities, Facebook has grown to have over 1 billion active users and became “the 

social network” as we know it. Facebook users can share news with their friends or publicly 

and this feature naturally made Facebook a great tool for people in the media sector -

mainstream or alternative. Media professionals use Facebook for news gathering, news 

sharing, finding sources, promoting their work and getting reaction on the content they 

share. 

Expanding Your Audience 

 Growing your Audience on Facebook takes a few steps that require constant attention.  

 Try learning by example! Take a look at the pages and people you enjoy following and 

figure out what is unique and interesting about them.  

 You can also expand your audience by letting your contacts know you are now a 

broadcaster and that your show is on Facebook. You can consider changing your email 

signature to also include a link to your radio show’s Facebook Page.  

 You can also click on ‘Build Audience’ and then ‘Invite friends’ in the Admin Panel of 

your Facebook Page. Each admin can immediately invite friends and Facebook contacts. 

 

Quick tips for growing and engaging your audience: 

 Be unique 

 Be interactive 

 Be trendy 

 Tag and engage others 
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Timing & Frequency: 

 Posting during peak hours (when is your key audience online?) and multiple times a day 

significantly increase your chances of being seen as well as more effectively reaching 

different audiences within your list/friend base.  

Photos and Videos 

Many studies found out that photos on Facebook Pages received more Likes than the average post. Similarly, photo posts 

attracted many more comments than the average post. 

 

According to HubSpot, the percentage difference is substantial and using photos and images 

points to a significant increase in Likes and comments. Boosts in Likes helps increase 

EdgeRank (Facebook's visibility algorithm based on users' interaction with your Facebook 

Page content), which can then cause a page's content to appear in News Feeds more often, 

increasing visibility." 

Engagement and Interaction: 

 Posting frequently will increase your visibility on followers' newsfeeds, and as you get 

more engagement on your posts, the more visible you will be! 

 Keep status updates concise as possible  

 When you post an article relevant to your show, try to include a brief statement or 

question about the article to draw attention 

 Use Facebook’s Page Insights to find out when your fans are online and which type of 

posts they engage with the most 

 Post when people are online and include a variety of your top-performing post types in 

each of your updates. 

 

 

HOMEWORK: Create Facebook and Twitter accounts for your “radio show” and using the 

information provided in this section, create 10 effective Facebook posts and 10 effective 

Tweets introducing and promoting the show. 
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